
Illustrated Parts Catalogs, Wiring Manuals, Maintenance Manuals, Structural Inspection 
Manuals, Airworthiness Limitations Manuals, Printed Circuit Board Manuals, Maintenance 
Schedules and all other technical publications included with Interactive Maintenance Library 
(IML) CD’s are available on the web.  To access the IML Online Manuals, you must be an active 
subscriber and registered on the website.  To be able to order Hawker Beechcraft Parts & 
Distribution (formerly known as Rapid) parts from the parts catalogs, make sure you are signed 
up with an HBP&D account.  

The Technical Publications website is located at http://pubs.hawkerbeechcraft.com.  The 
Technical Publications site can also be accessed by going to the Hawker Beechcraft home page 
(http://www.hawkerbeechcraft.com), click on Global Customer Support, Technical Publications, 
then the submenu Overview).  To view technical data (including technical manuals) users need 
to create a web account.  This is a one-time, no charge set-up.  For more information on 
registering on the site, refer to the Web Site Registration User’s Guide located in the Help/FAQ 
section of the Tech Pubs web site.

Online Manuals can be accessed by clicking on the IML Online Manuals link on the Tech Pubs 
home page (overview).  It can also be accessed by clicking on the IML Online Manuals link on 
the left-hand side of the screen from any Tech Pubs page.

Technical Publications Web Site
Interactive Maintenance Library 

Online Manuals User’s Guide
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The manuals you currently subscribe to are listed in the drop-down menu.  Click on the desired 
model to list those manuals. This menu also gives the part number, revision status and date of 
each manual. Click on View to open a specific manual. 

The Table of Contents menu for that specific manual appears which contains links to the various 
chapters.  
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Home

Returns back to the Online Manuals Main Menu.

Search

Enter the part number or part description (fragments may be used) then click Search.  Clicking the 
next to Help provides a pop-up with How-to-Perform searches. 

Navigation

To navigate and access features, use the IML Toolbar located below the Internet Explorer 
Menubar.

Note:  Do not use the Internet Explorer Standard Toolbar unless you want to close the 
Window.  To return to the Online Manuals menu, click on the IML Toolbar X.

Active Icon buttons are available for navigation, printing, searching, etc. Hold the mouse cursor 
over a button to provide a tool-tip that identifies the function of the button or pulls down additional 
features.
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Searches can also be performed from the book menu.

Zoom

Three magnification levels are available:  fit to page, zoom in and 
zoom out.

Display

Displays the table of contents, illustrations, parts list and shopping 
cart.

View TOC

Selects or deselects the table of contents.

August 2010 HBC IML Online Manuals User’s Guide Page 4 of 20



Add to Cart

Adds selected items to the shopping cart.

View Cart

Selects or deselects the shopping cart.

Help

IML Help contains information on navigation buttons, searches, filters and notes.  About This 
Book gives the current book’s title, part number, revision status and date.  About IML gives the 
current WebView version information.  If you cannot find the information in the help documentation, 
contact the IML Helpline (contacts are listed at the end of this document).

Parts Catalog Cart (Selected Parts List)

Detailed User Instructions are in the Comprehensive User Guide. See Appendix 2 for website 
support and additional contact information.
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Print

Prints the entire parts list with the option to print the graphic displayed or all illustrations.  Details 
printing instructions are in Appendix 1 of this User’s Guide.

Printing Defaults:

Paper Size = 8.5x11
Image Size = 100% 
Orientation = Portrait
Settings can be changed using the printer dialog box.

Navigation Arrows

 Go back to where you started from 
 
Step back along the point you followed navigating 
to this point 
 
Follow the path you took from here before 
 
 
Go to the next page in this book 
 
Go to the preceding page in this book 

Filters

The Filter Feature allows the user to customize the data with the book to only show parts applicable to 
the aircraft serial number entered.  

1.  Filter on the Toolbar.  The Click to Filter by Aircraft Serial No. is available throughout 
the manual.  Note:  be sure to enter the serial prefix (i.e., rk50, not 50).
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2. Filter on the Main Menu.  Note: this filter supplies a prefix selector.  For example, to filter 
for Beechjet RK-50, select “RK” in the prefix drop-down and enter “50” in the serial field.

When filtering is on, a notification appears on the far right of the toolbar and remains until you have 
cleared or changed the filter.

Searches

Enter the part number or part descriptions (fragments may be used) and click Search. (Clicking 
the     provides a pop-up with how to perform searches.) The Search For A Part box appears with 
the results.  Further searching may be done from this point. 
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Links in IPCs and WDMs

Entries with a link icon      or underlined text indicate a built-in cross-reference that links to further 
details.  Click to follow the link.  Blue text may indicate a link or a callout on a figure.

Shopping Cart

Add items to the shopping cart by checking one or more parts in the parts list then click the 
Add to Cart button.
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• To delete an item, click on the red     at the end of the part number.
• To change quantities, click in the Qty box and change the number.
• Click Clear All to remove all part numbers from the shopping cart.
• Click on the Print icon to print the shopping cart.
• Click Export to open or save the shopping cart in a .csv file for export to Excel or other 

spreadsheet program.
• Click the View Cart icon on the top menu to toggle between viewing and hiding the cart.
• Click on the part number in the shopping cart to link back to the part number location in the 

catalog.

Link to Hawker Beechcraft Parts & Distribution – HBP&D (formerly Rapid)

To order the parts from HBP&D, click on the Purchase Parts link.  The HBP&D website will open 
and your part number information will be displayed.  Follow the instructions to obtain Price and 
Availability.

Note:  If you reach a log-in screen, you may not have set up an account with HBP&D.  Return to your 
Profile and select Request Access under the HBC Parts tab.
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Graphics

Figure illustrations appear in the left window.  There are some differences between how IML CD 
users and online users Pan or Zoom graphics:

Panning
• Online Users – Press the Alt-Key and Hold down the left mouse button.  A hand appears 

for you to drag the graphic around the window. (NOTE: You can let go of the Alt-key once 
you are pressing and holding down the left mouse button.)

• CD Users – Hold down the right mouse button to pan (move the graphic around the 
graphic window after zooming in).

Scroll Bars
• Online Users - Vertical and Horizontal Scroll Bars are not available in the Web View 

version of the manuals. Use the Panning capability.
• CD Users - When the graphic is zoomed larger than the original full-size view Vertical and 

Horizontal Scroll bars on the Graphic window are available for moving around the face of 
the graphic.

Zooming
• Online Users - Press the Ctrl-Key and Hold down the left mouse button. A magnifier 

glass with a + appears. Draw a box around the area you want to zoom.  To print zoomed 
areas, see Appendix 1: Printing of this User’s Guide.

• CD Users - Hold down the left Mouse button and draw a box around the area you want to 
zoom.

Zoom Toolbar
• Online Users - View > Zoom Fit / In / Out This menu controls zooming on the picture in the 

picture frame. Zooming in can also be performed by double-clicking on the picture. 
Zooming out can also be performed by holding down the control-key and double-clicking. 
Zoom to fit zooms the picture to exactly fit the current size of the frame.   

• CD Users – Unavailable

Shortcut Menu
• Online Users - Right mouse click on the graphic for menu: Zoom In (Ctrl+Drag 

Mouse) – Zoom Out Original View.
• CD Users - Click Zoom on the Menu bar for Zoom Levels. NOTE: Shortcut Menus 

are unavailable in the CD version of IML.

Notes and Bookmarks

Notes and bookmarks available in the CD-ROM version are unavailable at this time in IML Online 
Manuals.
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Printing One Figure Using Internet Explorer (prints the figure title)

Appendix 1:  Printing

IML Online Manuals can be printed as follows:

Parts Catalog Figures print best through the IML Print Viewer. Parts Lists print best by building 
a Parts Shopping Cart List and printing/saving the list. 

Portable Document Formatted (PDF) documents are viewed and printed with Adobe Reader.

IML Maintenance Manuals can be printed using either the built-in Print Viewer or the Internet 
Explorer Print Function. 

Using Internet Explorer Print Function is in most cases the easiest method. 

Instructions are given for both Printing methods.

1. Close the Text window by Clicking 
Display and selecting Parts to toggle 
the text window “off”. 

2. This will allow the Picture window to 
expand and fill the entire screen. 
Select the Figure desired from the 
drop down box so that it shows on 
your screen.

3. On your Internet Explorer menu bar 
click File > Print Preview.

4. Change the Page View to 2 page 
view and desired Paper Orientation. 
(Drawing appears on page 2).

5. Click the print button and Select 
Page Range Pages: 2

6. Click Print. 

7. Click Display and select Parts to 
toggle the text window back “on”.
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Printing Zoomed Figure Using Internet Explorer (prints the figure title)

1. Close the Text window by 
Clicking Display and selecting 
Parts to toggle the text window 
“off”. 

2. This will allow the Picture 
window to expand and fill the 
entire screen. (To get your text 
window back, Click Display and 
select Parts to toggle the text 
window “on”).

3. Select the Figure desired from 
the drop down box so that it 
shows on your screen.

4. Ctrl+Left Mouse Button to get 
Magnifying Tool. Draw Box 
around area you wish to enlarge 
for printing.

5. Alt+Left Mouse Button to get 
Hand Tool for moving picture 
around the screen for best view 
– Center the enlarge section on 
the screen for best printout.

6. On your explorer menu bar click 
File > Print Preview

7. Change the Page View to 2 
page view.

8. Select paper orientation.

9. Change from ‘Shrink to Fit’ to 
100%.

10. Click the print button.

11. Select Page Range Pages: 2 
and Print.
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Printing Text Using Internet Explorer

1. Right click on the text (Prints ALL Text).

2. Click Print Preview... This allows you to preview the 
pages and print all of the pages or selected pages. 

NOTE: Selected text printing is currently 
unavailable. Copy/Paste selected text from the 
online version to Word or other text editing 
software. If copy/paste is used, you are 
responsible for all Warnings, Cautions, Notes 
and Procedures associated with any 
uncopied text/figures that are associated 
with the selected text. 
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Printing from the Built-in IML Print Viewer

Notice Text and the Figure(s) are no longer displayed side-by-side. 

The Print Viewer displays Figure(s) and Text in vertical windows. The figure and text windows 
are connected by a scroll bar and separated by horizontal line(s). The Text Window falls below 
the figure(s) window(s) and contains it’s own scroll bar to scroll the text. 

Click Print on the IML Menu Bar to Open the Print Viewer.

NOTE: The Figure Print Dialog will open even if the document you are printing does not have 
any figures. If you Click Print you will get a blank page with header information.

KEY: Print Jobs from the IML Print Viewer are always sent as two separate Print Jobs.

• Figures are sent first followed by Text.  

• Figure Printing is controlled by the first Print Dialog Box that appears. 

• Text Printing is controlled by the second Print Dialog Box.

• You can choose to print or cancel printing either the figure(s) or the text jobs.

The second Print Dialog Box appears when the first job is either canceled or printed and 
sends the text which you can choose to either print or cancel the text printing.

If the document has Figures, the figure showing in the document’s picture window when the 
IML Print Button is clicked displays in the Print Viewer along with the documents text/parts 
list.
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Print Viewer Menu Bar Settings

Close – Exits the Print Viewer
Print – Opens Print Dialog Boxes
All Pictures – Displays All Figures in the current document for printing.

CAUTION: Hyperlinks are not active in the Print Viewer windows. If you click a link in 
the Print Window You get an error that the webpage cannot be displayed. If 
this occurs, close the error message window to go back to the IML 
document and Start Over.

Only the Figure printouts display the source of the document on the first page of the print job as 
follows:

Publisher: Hawker Beechcraft Corporation
Book: Model and type of Manual (i.e. Model 400/400A Maintenance Manual)
Page: Title of the Page (i.e. Main Landing Gear and Doors - Description and Operation)
Item: 

NOTE: ATA, Figure Numbers and Figure Titles do not print at this time. 

If you want to print one figure in particular out of several in a document, that Figure has to be 
displayed in the document’s picture window at the time of printing. 

Select the Figure you want to print from the Figure Drop Down box containing Figure Numbers 
and Titles located above the Figure Window.

Printing Figure(s) and Text

Printing One Figure With or Without Text
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Click Print on the IML Menu Bar.

Click Print on the Print Viewer Menu

Print Dialog Box for Figures opens

Click Print

WITHOUT TEXT
A Second Print Dialog Box Opens for printing 
the text after the Figure Print Job has gone to 
print. If you do NOT want to print the text 
Click Cancel for the second Print Dialog Box.

WITH ALL OF THE TEXT
If you want to print the text and the Picture 
then Click Print on the Second Print Dialog 
Box. 

WITH ALL TEXT – WITHOUT FIGURE(S)
Cancel the first Print Dialog Box. The second 
dialog box prints the text.
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Printing All of the Figures With or Without Text

When printing ALL of the figures it doesn’t matter which figure is currently displayed in the 
document picture window.

Click Print on the IML Menu Bar to open the Print Viewer. 

Click All Pictures Button to import all of the figures

Click Print on the Print Viewer Menu

Print Dialog Box for Figures opens

WITHOUT TEXT
A Second Print Dialog Box Opens for 
printing the text after the Figure Print Job 
has gone to print. If you do NOT want to 
print the text Click Cancel for the 
second Print Dialog Box.

WITH ALL OF THE TEXT
If you want to print the text and the 
Picture then Click Print on the Second 
Print Dialog Box. 
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Printing a Zoomed View from the Print Viewer

If you zoom a picture in the document picture window prior to clicking the Print button the picture will 
not appear in the Printer View as a zoomed picture. 

Select the Figure you want to ZOOM from the Figure Drop Down box above the Figure Window. 
Do NOT Zoom in on the picture at this time. 

Click Print on the IML Menu Bar.

Find the area on the Figure you want to enlarge. HINT: Press the Alt-Key and Hold down the left 
mouse button.  A hand appears for you to drag the graphic around the window to desired area. 

Press the Ctrl-Key and Hold down the left mouse button. A magnifier glass with a + appears. 
Draw a box around the area you want to zoom. 

NOTE: Right click anywhere on the picture and select Original View to return to full-sized picture. 
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Printing Text

Click Print on the Print Viewer Menu

Remember, a Second Print 
Dialog Box will open for printing 
the text after the Figure Print Job 
has gone to your printer. If you 
do NOT want to print the text 
Click Cancel.

NOTE: If you want the text with 
the Zoomed figure then Click 
Print on the Second Print 
Dialog Box. 

Click Print

Printing Text and Figures

Follow the Instructions above for printing any figure configuration (One Selected Figure, 
All Figures, Zoomed Figure) and Click Print on the Second Print Dialog Box that prints 
text.  

Printing Text Only (No Figures)

Follow the Instructions above for printing one figure and cancel the first Print Dialog Box 
that prints figures. 
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Technical Manual Distribution Center
Manual Sales & Subscriptions

Interactive Maintenance Libraries/
Online Manuals

Monday through Friday 8:00 am to 4:30 pm Central time
(Note: during off-hours, leave a voicemail or email message and 

your inquiry will be addressed within one business day.)

800.796.2665 toll free
316.676.8238 local/international
316.671.2540 fax
tmdc@hawkerbeechcraft.com e-mail

800.240.2959 toll free
316.676.3053 local/international
316.676.6706 fax
IML@hawkerbeechcraft.com e-mail

http://pubs.hawkerbeechcraft.com

How To Articles detailing specific features/functions are available at: 
https://www.hawkerbeechcraft.com/customer_support/technical_publications/iml_support/ (Click 
the How-To Documents).  Additional IML support is also available on this site.  Questions can 
be submitted by clicking on Submit a Question.

Appendix 2:  Contact/Help Line Information
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